
Chapter 3
		  Part Modeling - I

Leaning Objectives
After completing this chapter, you will be able to:
• Understand the DesignModeler Workspace.
• Draw sketches.
• Convert sketches into 3D models.
• Understand views of the model in 3D space.
• Apply constraints and relations.
• Create new sketching planes.
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Introduction to Part Modeling
For conducting an FEA analysis, a part model is mandatory. In ANSYS Workbench, the next 
step after defining the material properties is to define the geometry to which the material 
properties will be applied. Like most of the other CAD modeling packages, the part models 
created in ANSYS Workbench are parametric and feature based. The parametric nature of an 
application is defined as its ability to use the standard properties or parameters (dimensions) 
in determining the shape and size of the geometry. You can also modify the shape and size 
of the model using these parameters. Feature is defined as the smallest building block of the 
model that can be modified individually.

Most of the 3D models created using ANSYS Workbench are a combination of sketched and 
placed features. The placed features are created without drawing a sketch, but the sketched 
features require a sketch to be drawn first. Generally, the base feature of any 3D model is 
a sketched feature and is created using a sketch. Therefore, while creating any design, you 
first need to draw the sketch for the base feature. Once you have drawn the sketch, you can 
convert it into the base feature and then add the other sketched and placed features to it to 
complete the 3D model.

In general terms, a sketch is defined as the basic contour for the feature. For example consider 
the spanner shown in Figure 3-1. It is created using a single sketch drawn on the XY plane, 
as shown in Figure 3-2. 

Figure 3-1  Base feature of the spanner Figure 3-2  Sketch for the base feature of the 
spanner

Introduction to DesignModeler window 
In ANSYS Workbench, the part models and their sketches are defined in the DesignModeler 
window. You can define part models either by importing the CAD model created in some 
other CAD applications such as Pro/E, SolidWorks, and so on, or by creating the model in the 
DesignModeler window of ANSYS Workbench 14.0.
 
In any system, the DesignModeler window is associated with the Geometry cell. The Geometry 
cell can be added to any analysis project as a standalone component system or as a part of any 
mechanical analysis system. Figure 3-3 displays system A as a standalone component system. In 
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system B, the standalone system A is used as a part of an analysis system. In analysis system C, 
the model will be defined in the DesignModeler window that is associated with the Geometry 
cell of the same system.

Figure 3-3  Project Schematic window displaying various standalone systems in it

To open the DesignModeler window, double-click on the Geometry cell in an analysis system; 
the DesignModeler window along with the ANSYS Workbench dialog box will be invoked. 
Alternatively, right-click on the Geometry cell of any analysis system and choose the New 
Geometry option from the shortcut menu displayed.

   
The ANSYS Workbench dialog box is the startup dialog box that is displayed along with the 
DesignModeler window. When this dialog box is opened, you are prompted to specify the unit 
to be used for creating the models. Select the radio button corresponding to the desired unit 
of length. To always use the unit specified in this dialog box, select the Always use selected 
unit check box. However, you can also use the unit system specified for the project in the 
Workbench window by selecting the Always use project unit check box. Note that only one 
check box can be selected at a time. After specifying the units and your preferences, choose 
the OK button from the ANSYS Workbench dialog box; the DesignModeler window will be 
activated, as shown in Figure 3-4.

Note
1. If you select the Always use project unit check box or the Always use selected unit check 
box then the ANSYS Workbench dialog box will not be displayed along with the DesignModeler 
window. However, if you want to display the ANSYS Workbench dialog box at the start of new 
DesignModeler session, choose Tools > Options from the Menu bar in the DesignModeler 
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window; the Options dialog box will be displayed. Expand the DesignModeler node from the 
left pane of the Options dialog box and select the Units sub option; the corresponding options 
will be displayed in the right pane. Click on the Display Units Pop-up Window option from 
the right pane; a drop-down list will be displayed on the right of this option. Select the Yes option 
from this drop-down list.

Figure 3-4  The DesignModeler window

The DesignModeler window can be used in two basic modes that are discussed next.

Sketching Mode
The Sketching mode is used to draw 2D sketches. Later on, these sketches can be converted into 
3D models using the Modeling mode. To invoke the Sketching mode, choose the Sketching 
tab from the DesignModeler window, refer to Figure 3-4. The Sketching mode displays the 
Sketching Toolboxes window which contains five toolboxes. These toolboxes are used to 
create, modify, and dimension the sketches, refer to Figure 3-5.

Modeling Mode
The Modeling mode is used to generate the part model using the sketches drawn in the 
Sketching mode. By default, the Modeling mode is active when the DesignModeler window is 
invoked. If not, choose the Modeling tab from the DesignModeler window, refer to Figure 3-4. 
In the Modeling mode, the Tree Outline is displayed on the left of the Graphics window which 
contains three default planes. Apart from three default planes, the list of all operations that 
are used to create a model in the Modeling mode will be listed in the Tree Outline in the 
sequence they are performed, refer to Figure 3-6.
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Figure 3-5  The Sketching Toolboxes window Figure 3-6  The Tree Outline

  

Screen components of the DesignModeler 
Window
The various screen components of the default DesignModeler window and important terms 
related to this window are discussed next.

Tree Outline
In ANSYS Workbench three planes XYPlane, YZPlane, and ZXPlane corresponding to the 
XY, YZ, and ZX planes of cartesian coordinate system are created by default and are displayed 
in the Tree Outline. These planes are used as sketching planes for drawing the sketches to be 
used for generating the part model. 

A sketch is a collection of 2D drawing entities which is used

Figure 3-7  The XY plane displayed when 
XYPlane is selected in the Tree Outline

 
for generating the features of a part model. The sketch 
can be created on any one plane. However, a single 
plane can have multiple sketches associated with it. The 
plane for creating the sketch can be specified by 
selecting it from the Tree Outline. When you click on a 
plane in the Tree Outline, it is displayed in the Graphics 
window. Figure 3-7 shows the plane that will be displayed 
on selecting XYPlane from the Tree Outline.

Note
1. The last sketching plane you worked on will act 
as the active plane for any future operation, unless 
and until you change the plane by selecting it from the Tree Outline.
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2. Apart from these three default planes, the user can also create new planes at the specified 
location and orientation in the Graphics window. The method of creating new planes will be 
discussed in detail in the later chapters.     

3. To start a new sketch, choose the New Sketch tool from the Active Plane/Sketch toolbar. 
On doing so, a new sketch instance will be added under the desired plane in the Tree Outline. 
Alternatively, you can select the desired plane in the Tree Outline and then switch to the Sketching 
mode and draw a sketch. On doing so, a sketch instance will automatically be added under the 
selected plane.

Details View Window
The Details View window located near the Graphics window

Figure 3-8  The Details View 
window

 
is contextual in nature and changes its content according to 
the selection made in the Tree Outline. Figure 3-8 shows the 
Details View window which is displayed when the Extrude1 
is selected in the Tree Outline. You can also modify the selected 
entity by editing its parameters in the Details View window. 

Model View/Print Preview 
The Model View and the Print Preview tabs are located 
at the lower left corner of the Graphics window, refer to 
Figure 3-4. By default, the Model View tab is chosen in the 
DesignModeler window. Subsequently, the sketches and the 
part model are displayed in this interface. To preview the 
current view of the model, choose the Print Preview tab. After previewing the model, choose 
File > Print from the Menu bar to print it. Note that the option to print the model will be 
available only in the Print Preview mode.

Ruler
The Ruler is displayed at the bottom of the Graphics window, refer to Figure 3-9. The Ruler 
helps the user to visualize and compare the actual size of the model with the size of the 
model displayed. The number displayed at the end of each block in the Ruler represents the 
cumulative length of the blocks on the left of the number. The quantity shown in brackets at 
the extreme right of the ruler represents current unit of the length. To toggle the display of 
the Ruler in the Graphics window, choose View > Ruler from the Menu bar.  

  

Triad
The Triad is displayed at the lower right corner of the Graphics window, refer to Figure 3-10. 
Triad helps the user to visualize the X, Y, and Z directions in the Graphics window. To toggle 
the display of the Triad in the Graphics window, choose View > Triad from the Menu bar. 
Move the cursor to any axis, its name will be displayed attached to the cursor. Moving the 
cursor in the negative direction of the three orthogonal axis system displays the temporary 
view of the axis and its name with a negative symbol (-). If you click on any axis system, the 
view will get oriented normal to the selected axis. Click on the ISO ball (cyan color) displayed 
at the center of the triad to orient the model in the Isometric view.
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Figure 3-10  The TriadFigure 3-9  The Ruler

Status Bar
The Status bar is located at the bottom of the screen, refer to Figure 3-4. The instructions for 
the currently active tool and its status are displayed on the left of the Status bar. The middle 
portion of the Status bar displays the information about the currently selected object. The 
right portion of the Status bar displays the current unit system and the coordinate value of 
the cursor location.

Tutorials
Tutorial 1

In this tutorial, you will create the I-section solid model shown in Figure 3-11. The dimensions 
of the model are shown in Figure 3-12. Save the project with the name c03_ansWB_tut01 at 
the location C:\ANSYS_WB\c03\Tut01	 	   		   (Expected time: 30 min)

 

Figure 3-12  Dimensions of the I-sectionFigure 3-11  Model for Tutorial 1

	 The following steps are required to complete this tutorial:

a.	 Start ANSYS Workbench 14.0 and add the Geometry component system.
b.	 Create the sketch for the outer loop of the I-section.
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c.	 Apply constraints to the sketch.
d.	 Generate dimensions and edit them to achieve the required size of sketch.
e.	 Create the base feature.
f.	 Create the second feature.
g.	 Create the blend feature.
h.	 Rotate the view of the model dynamically.
i.	 Save the project and exit the ANSYS Workbench session.

Starting ANSYS Workbench and Adding the Component System
	 First you need to start ANSYS Workbench and then add an analysis system to the Project 

Schematic window.

1.	 Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu to start the 
ANSYS Workbench session; the Getting Started window is displayed with the Workbench 
window.

2.	 Choose the OK button to close the Getting Started window.

Note
1. If you do not want the Getting Started window to be displayed the next time you start a new 
session of ANSYS Workbench, clear the Show Getting Started Message at Startup check box 
located at the bottom of the Getting Started window and then close it.   

2. If you want the Getting Started window to be displayed at the startup of a new ANSYS 
Workbench session, choose Tools > Options from the Menu bar; the Options dialog box will 
be displayed. Next, choose Project Management from the left pane of the Options dialog box,  
if not chosen by default. Scroll down in the right pane and select the Show Getting Started 
Dialog check box.

3.	 Double-click on Geometry displayed under the Component Systems toolbox in the 
Toolbox window; the Geometry component system is added and displayed in the Project 
Schematic window, refer to Figure 3-13.

After the Workbench window is displayed and an analysis system is added to the Project 
Schematic window, the first step in any analysis is to define the geometry. There are two ways to 
define a geometry: by creating a new geometry and by importing an already created geometry 
from any solid modeling software. The DesignModeler window is used to create and edit 
geometries which are used in ANSYS Workbench. In ANSYS Workbench 14.0, a standalone 
system known as Geometry component system, is available to create geometries. Figure 3-13 
shows a Geometry component system added to the Project Schematic window.

	 Now, you need to save the project.

4.	 In the Workbench window, choose the Save button from the Standard toolbar; the Save 
As dialog box is displayed.
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Figure 3-13  The Geometry component system added to the 
Project Schematic window

5.	 Browse to the location C:\ANSYS_WB.

6.	 Create a folder with the name c03 in the ANSYS_WB folder and then then double-click 
on the newly created c03 folder to open it. Next, create a sub folder with the name Tut01 
under the c03 folder and then choose the Open button from the Save As dialog box.

7.	 Enter c03_ansWB_tut01 in the File name edit box and choose the Save button from the 
Save As dialog box; the project is saved with the name specified.

Creating the Sketch
	 You now need to invoke the DesignModeler window to create the sketch.

1.	 Right-click on the Geometry cell of this component system to display a shortcut menu. 
Next, choose New Geometry from the shortcut menu; the Starting DesignModeler 
message is displayed in the status bar. After sometime, the DesignModeler window is 
displayed along with the ANSYS Workbench dialog box.

2.	 In the ANSYS Workbench dialog box, select the Millimeter radio button and accept the 
default settings for other check boxes. Next, choose the OK button to close the dialog 
box.

	 Next, you need to select the plane in which you want to create the sketch for the 
tutorial. 

3.	 Select XYPlane in the Tree Outline that is displayed in the left pane of the DesignModeler 
window.

The Tree Outline in the DesignModeler window lists all the operations that are carried out 
on the model. The Tree Outline for Geometry component system is shown in Figure 3-14. 
Note that the operations in the Tree Outline are listed in the sequence in which they were 
created. 



3-10					     ANSYS Workbench 14.0: A Tutorial Approach
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 3-14  The Tree Outline 
displayed in the DesignModeler 
window

4.	 Choose the Sketching tab available at the bottom of the Tree Outline to display all the 
tools available for creating sketches.

	 Since the XY plane has already been selected for drawing the sketch, as shown in 
Figure 3-15, you need to orient the plane normal to the viewing direction. 

5. 	 Right-click anywhere in the Graphics window and choose the Look At tool from  
the shortcut menu; the view is oriented as required, refer to Figure 3-16.

Figure 3-15  The default Isometric view of 
the XY plane

Figure 3-16  XY plane after choosing Look At 
tool from the Graphics toolbar

The Look At tool is used to orient the plane on which the sketch

Figure 3-17  The Graphics 
toolbar

 
is drawn, normal to the viewing direction. You can invoke this tool 
from the Graphics toolbar, refer to Figure 3-17. Alternatively,  
invoke this tool from the shortcut menu which is displayed on 
right-clicking anywhere in the Graphics window.
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	 Next, you need to create the sketch, refer to Figure 3-18. For ease of creating the sketch, 
the entities of the sketch have been numbered, refer to Figure 3-18.

6.	 From the Draw toolbox, choose the Line tool which is displayed by default; the Status bar 
displays the message Line -- Click, or Press and Hold, for start of line.

Figure 3-18  Sketch for Tutorial 1

A line is defined as the shortest distance between two points. A line is one of the basic sketching 
entities available in the DesignModeler window. To draw a line, choose the Line tool from 
the Draw toolbox in the Sketching Toolboxes window. On doing so, you will be prompted to 
specify the start point of the line. Click anywhere in the Graphics window to specify the start 
point; you will be prompted to specify the end point of the line. Next, click to specify the end 
point of the line; a line will be created.

After specifying the start point of the line, if you realize that the specified start point is 
wrong, right-click in the Graphics window and choose the Back option from the shortcut 
menu displayed. As a result, the specified start point will get nullified without exiting the 
Line tool.

7.	 Move the cursor close to the origin in the Graphics window and click to specify the start 
point of the line when the symbol of Coincident Point constraint (P) is displayed, refer to 
Figure 3-19.

After specifying the start point of the line, if you move the cursor horizontally, an H symbol 
will be displayed on the line. This symbol indicates that if you specify the end point of the 
line at the current location, a horizontal line will be drawn. Similarly while drawing a line 
close to an existing line, if C symbol is displayed, it indicates that the end point specified at 
the current location of the cursor will be coincident with the existing line.
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Figure 3-19  Specifying the start point of the 
line

Figure 3-20  Specifying the end point of the 
line

Table 3-1  List of auto constraints
 

Auto Constraint 
Name

Symbol Description

Horizontal H Makes the entity horizontal

Vertical V Makes the entity vertical

Parallel // Makes the entity parallel to another entity

Perpendicular Makes the entity perpendicular to another entity

Tangent T Makes the entity tangent to another entity

Equal Radius R Makes the entity equal to another entity

Coincident C Makes the end point of an entity coincident with 
another  entity

Coincident Point P Makes the end point of the current drawing entity 
coincident with a point.

8.	 Move the cursor toward right to some distance and click to specify the end point of line 
when the symbol of Horizontal constraint (H) is displayed, as shown in Figure 3-20. 
Line 1 is created and its blue color indicates that the line is fully constrained, refer to 
Figure 3-21.

9. Next, move the cursor close to the end point of line created in the last step; the symbol of 
Coincident Point constraint (P) is displayed. Click to specify the start point of the second 
line, refer to Figure 3-21.

10.	 Move the cursor vertically upward;  the symbol of Vertical constraint (V) is displayed. Click 
to specify the end point of the line; line 2 is drawn, as shown in Figure 3-22.

11.	 Now, move the cursor close to the end point of line 2 created in the last step; the symbol 
of Coincident Point constraint (P) is displayed. Click at that point to specify the first point 
of line 3, as shown in Figure 3-23.
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Figure 3-21  Specifying the startpoint of line 2 Figure 3-22  Specifying the endpoint of line 2

12.	 Move the cursor toward left to some distance; the symbol of Horizontal constraint (H) is 
displayed. Next, Click to specify the end point of line 3, as shown in Figure  3-24.

13.	 Move the cursor close to the end point of line3; the symbol of Coincident Point constraint (P) 
is displayed. Click at that point to specify the start point of line 4, as shown in Figure 3-25.

Figure 3-23  Specifying the startpoint of the 
line 3

Figure 3-24  Specifying the endpoint of line 3

14.	 Move the cursor upward to some distance; the symbol of Vertical constraint (V) is displayed 
along the cursor. Click to specify the end point of line 4, refer to Figure 3-26.

Figure 3-25  Specifying the startpoint of the line 4 Figure 3-26  Specifying the endpoint of line 4
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15.	 Similarly, draw all the lines specified in the

Figure 3-27  The sketch drawn using 
automatic constraints

 
sketch. The sketch drawn is just a representation 
of the final sketch to be drawn based on 
dimensions. The final sketch before applying 
the constraints and dimensions is shown in 
Figure 3-27.

Note
1. The sketch shown in Figure 3-27 is just 
for reference and is not created based on 
dimensions.
 
2. While drawing the sketch, some of the 
constraints like Horizontal, Vertical and 
Coincident are automatically applied. You can 
also apply constraints manually after drawing 
the sketch, by choosing the desired constraint tool from the Constraints toolbox.

Applying Constraints to the Sketch
	 After a sketch for the model is drawn, refer to Figure 3-27, you need to constrain the 

entities of the sketch to restrict some degrees of freedom. 

1.	 Expand the Constraints toolbox in the Sketching Toolboxes window.

2.	 Choose the 	Horizontal tool from the Constrains toolbox; the Horizontal  
-- Select line or ellipse for horizontal constraint message is displayed in 
the Status bar indicating that the Horizontal constraints can be applied to entities of the 
sketch.

Horizontal constraint is used to make a line or the major axis of an ellipse horizontal.

3.	 Select lines 1, 3, 5, 7, 9, and 11 one by one to make them horizontal, if not already 
horizontal, refer to Figure 3-20.

4.	 Next, choose the Vertical tool from the Constraints toolbox; the Vertical --  
Select line or ellipse for vertical constraint message is displayed in the 
Status bar indicating that you can now apply vertical constraints to entities.

Vertical constraint is used to make a line or the major axis of an ellipse vertical.

5.	 Select the lines 2, 4, 6, 8, 10, and 12 one by one to apply vertical constraints to them; all 
these lines become vertical now, refer to Figure 3-28.

	 The next step is to apply Equal Length constraints to lines which are equal in length. 

6.	 Choose the Equal Length tool from the Constraints toolbox of the Sketching  
Toolboxes window. Use the down arrow available next to the Settings 



Part Modeling - I	  3-15

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

toolbox tab to scroll down and view the Equal Length tool, if it is not visible by default; 
you  are prompted to select the first line to apply Equal Length constraint.

7.	 Move the cursor close to line 1; a rectangular box is attached to the cursor, which means 
that you can now select the line to apply Equal Length constraint. Select line 1; it turns 
yellow and you are prompted to select the second line. 

8.	 Select 7; the Equal Length constraint is applied and both the lines become equal in 
length.

9.	 Similarly, apply Equal Length constraint between the lines 2 and 12, 6 and 8, and 2 and 
6  to make these lines equal. In addition, make the lines 3, 5, 9, and 11 equal in length. 

10. Next, apply Equal Length constraint to lines 4 and 10. 

Applying Dimensions to the Sketch
	 Now you need to apply dimensions to the sketch. To apply dimensions to the sketch, you 

need to invoke the desired tool from the Dimensions toolbox tab.

1.	 Choose the Dimensions toolbox from the Sketching Toolboxes window to expand it.

2.	 Choose the General tool from the expanded Dimensions toolbox; the Details View 
window is displayed. Also, you are prompted to select first point or 2D edge for applying 
Horizontal dimension.

 
The General tool is used to create dimensions depending upon the entities selected. After 
the General tool is invoked, select an entity from the Graphics window to dimension it,  

3.	 Move the cursor close to line 1; a rectangle is attached to the cursor. Select the line 1; the 
cursor changes to pencil shape. Click to place dimension. As the line is horizontal, H1 is 
placed above the line 1.

Note
In DesignModeler, the dimensions are placed as symbols. For example, when you invoke the 
Horizontal tool from the Dimensions toolbox and then dimension an entity, the dimension that 
would be placed is H1. The values of all the placed dimensions in the sketch can be changed 
by changing the corresponding dimensional values under the Dimensions node in the Details 
View window. 

4.	 Similarly, select the line 8 and place dimension V2 to the left of the line.

5.	 Select line 9, and place dimension H3 below the line.

6. 	 Select line 10 and place dimension V4 below V2, as shown Figure 3-28.
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Figure 3-28  Sketch after applying dimensions

Note
1. When line 11 is selected for dimensioning, the Geometry - DesignModeler warning message 
box is displayed, as shown in Figure 3-29. This message states that placing this dimension will 
over-constrain the sketch and you can edit and place this dimension as a reference. On choosing 
the OK button from the warning message box, the dimension of line 9 will turn red, indicating 
that the sketch is over-constrained, as shown in Figure 3-30.

2. If you want to place the over-constrained dimension, place it on the sketch, as shown in 
Figure 3-31.

Figure 3-29  Warning messege 

	 To undo changes, click anywhere in the Graphics window and then press CTRL+Z keys; 
over-constrained dimensions will vanish.

Tip. By default, the name of the dimension is displayed on the dimension line. 
However, if you want to display the value of the dimension or both the name 
and value of the dimension on the dimension line, choose the Display tool from 
the Dimensions toolbox. On doing so, the Name and Value check boxes will 
be displayed on the right of the Display tool. Select the respective check box, the 
corresponding parameter will be displayed on the dimension lines in the Graphics 
window. Note that you cannot clear both the check boxes at the same time.
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Figure 3-30  Over-constrained sketch Figure 3-31  Placing dimension on sketch

Assigning Dimensional Values to the Sketch
	 After dimensions are assigned to the sketch, you need to change their values to get the 

exact dimensions. 

1.	 In the Tree Outline, choose the Modeling tab to view the Tree Outline. On doing so, the 
Details View window is also activated with various nodes active in it.

2.	 Expand the Tree Outline, if it is not already expanded and then expand the XYPlane node 
to view Sketch1. Select Sketch1; the Details View window with corresponding parameters 
is displayed.

3.	 Expand the Dimensions node in the Details View window, if it is not already expanded.

	 There are four dimensions present under this node : H1, H3, V2, and V4. These dimensions 
refer to the dimensions of lines 1, 9, 8, and 10, respectively.

4.	 To assign a different dimension, click on the edit box to the right of H1; the corresponding 
dimension is highlighted in yellow in the sketch. Enter 120 as the new dimension value 
and then press ENTER; the lengths of lines 1 and 7 are changed.

Note
1. As you specify the dimensional values to a dimension in the Details View window, the length 
of the entity is changed and the length of the entities which are constrained along with this entity 
are also modified.

2. While changing the dimensions, the complete sketch may not fit in the screen of your 
computer. To fit the sketch in the screen, choose the Look At tool from the Graphics 
toolbar. 

5.	 Next, in the Details View window, click on the edit box next to H3; the corresponding 
dimension is highlighted in the sketch. Enter 30 as the new dimension value and then 
press ENTER; the length of lines 3, 5, 9, and 11 is changed. 



3-18					     ANSYS Workbench 14.0: A Tutorial Approach
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

6.	 Click on the edit box on the right of V2; the corresponding dimension is highlighted in 
yellow in the sketch. Enter 20 in the edit box and then press ENTER; the length of lines 
2, 6, 8, and 12 is changed in the sketch.

7.	 Click on the edit box on the right of V4; the corresponding dimension is highlighted in 
yellow in the sketch. Enter 50 in the edit box and then press ENTER; lines 4 and 10 are 
modified.

	 You will notice that as soon as H1, V2, H3, and V4 are modified in the Details View 
window, the whole sketch is modified. Therefore, changing the dimension of one entity 
will ensure that the dimensions of all other entities which are equal in length are also 
modified.

Extruding the Sketch 
	 After creating the sketch of the outer profile of the I-section, you need to convert it into 

the base feature by using the Extrude tool. The Extrude tool is used to add or remove 
material from the specified sketch along a straight line in the specified direction.  

1.	 Click on the ISO ball placed at the bottom right in the Graphics window; the view is 
changed to Isometric, as shown in Figure 3-32.

 
2.	 Choose the Extrude tool from the Features toolbar; the preview of the  

extruded feature with default values is displayed in the Graphics window, 
as shown in Figure 3-33. Also, Extrude1 is added under the three default planes in the 
Tree Outline, as shown in Figure 3-34.

Figure 3-32  The Isometric view of the sketch Figure 3-33  The preview of feature 
after choosing the Extrude tool

Note
1. The sketch plane on which you worked last acts as an active plane for any future operation, 
until you change the plane.

2. To remove material from a feature, you need to have the base feature. Therefore, you cannot 
use the Extrude tool for material removal before you create the base feature.
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The default parameters used for generating the preview of the extruded feature are displayed 
in the Details View window. To get the required shape of the base feature, you need to edit 
parameters specified in each node of the Details View window. The Both-Symmetric option 
is used to add material on both the sides of the sketch with same depth of material.

3.	 Based on the design requirements, the material should be added normal and symmetrically 
on both sides of the sketch. To add material to the extrusion, click on Direction; a down 
arrow is displayed on the right of Direction in the Details View window. Next, click on 
the down arrow and select the Both-Symmetric option from the list displayed, as shown 
in Figure 3-35. The preview of the extruded feature is changed in the Graphics window 
and now it displays the same amount of material added on both sides of the sketch.

Figure 3-35  Selecting the Both-symmetric option from 
the  Direction drop-down list in the Detail View window

Figure 3-34  The Tree Outline with 
Extrude 1 added to it 

The Reversed option in the Direction drop-down list is used to reverse the direction of material 
addition. The Both-Asymmetric option is used to add material on both the sides of sketch 
with different values of the depth of material addition.

	 Next, you need to specify the depth of material addition. 

4. 	 Enter 25 in the FD1, Depth (>0) edit box of the Details View window, refer to 
Figure 3-36.   

Figure 3-36  Specifying the depth of material addition in the 
Details View window
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	 The total depth of material addition is 50 mm, but the material will be added symmetrically 
by the same depth on both the sides of the sketch. Therefore, 25 mm has been specified 
as the depth value. 

	 After all the parameters in the Details View window are specified, the preview of the 
extrude feature is displayed in the Graphics window. To create the solid model, you need 
to generate the extrude feature. Also, notice the thunderbolt symbol displayed before 
Extrude 1 in the Tree Outline, which indicates that the feature needs to be generated. 

	 Next, you need to complete the extrusion process with the specified values.

5.	 Choose the Generate tool from the Features toolbar; the base feature is created  
with the specified settings, refer to Figure 3-37. Also, the thunderbolt symbol 
is changed to green tick mark indicating that the feature is updated.

The Generate tool is available in the Features toolbar and is used to update the model after 
any changes are made in it. This tool can also be invoked from the shortcut menu which is 
displayed on right-clicking anywhere in the Graphics window.

Figure 3-37  Resulting base feature

Tip. Instead of choosing the Generate tool from the Features toolbar, you can 
press the F5 key to generate a feature. 

Creating the Second Feature
	 Next you need to create a rectangular cutout in the I-section, refer to Figure 3-11. To 

create a rectangular cutout, you will draw a sketch on the XY plane. Next, you will remove 
material by extruding he sketch.

1.	 Select XYPlane from the Tree Outline; the XY plane becomes the active plane.

2.	 Choose the New Sketch tool from the ActivePlane/Sketch toolbar; the new entry  
with the name Sketch2 is added under the XYPlane node in the Tree Outline, 
refer to Figure 3-38.
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The New Sketch tool is available in the Active Plane/Sketch toolbar located just above the 
Graphics window. This tool is used to create new sketches for the models.

	 Notice that the Sketch 1 and the dimensions are still displayed in the Graphics window. 
Since this sketch is not required, you can hide its display.

3.	 Right-click on Sketch1 in the Tree Outline and then choose the Hide Sketch option from 
the shortcut menu displayed, refer to Figure 3-39. 

Note
If needed, you can display the sketch and its dimensions again. To do so, right-click on Sketch1 in 
the Tree Outline and then choose the Show Sketch option from the shortcut menu displayed.

Figure 3-38  The Tree Outline with 
Sketch2 added to it 

Figure 3-39  Hiding Sketch1 by selecting the 
Hide Sketch option from the shortcut menu

4.	 Select Sketch 2 from the Tree Outline and then choose the Sketching tab displayed at 
the bottom of the Tree Outline to invoke the Sketching mode.

5.	 Choose the Look At tool from the Graphics toolbar; the sketching plane is oriented  
normal to the viewing direction. Orienting the sketching plane enables you to easily 
draw the sketch.

6.	 Choose the Rectangle tool from the Draw toolbox; the cursor changes  
into the Draw cursor and you are prompted to specify the first corner 
point of the rectangle.

In the DesignModeler window, there are two methods of drawing rectangle: by specifying 
two diagonally opposite points of the rectangle and by specifying the three corners of the 
rectangle The rectangle created by using the first method can be either horizontal or vertical. 
The rectangle created by the second method is placed at an orientation specified by the user. 
You can use any of the two methods for drawing the rectangle using the Draw toolbox.

7.	 Specify the first corner point, refer to Figure 3-40; the preview of the rectangle is attached 
to the cursor and you are prompted to specify the diagonally opposite corner point of the 
rectangle.
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8.	 Click to specify the second point of the rectangle, refer to Figure 3-40; the rectangle is 
created, refer to Figure 3-41.

Figure 3-40  Specifying the first and second 
corner points of the rectangle

Figure 3-41  The rectangle created

9.	 Press the ESC key to exit the Rectangle tool.

	 After creating the rectangle, you need to generate its dimensions so that you can specify 
the size of the rectangle and place it at the desired location.

10.	 Expand the Dimensions toolbox in the Sketching Toolboxes window.

11.	 Choose the General tool from the Dimensions toolbox, if not chosen  by 
default.

12.	 Select Line 1; the preview of dimensional constraint attached to the cursor is displayed.

13.	 Click below the Line 1 to place the dimension; the dimension is generated and its value 
is displayed on the dimension line.

	 Next, you need to generate a dimension between Line 4 and the Y axis. 

14.	 Move the cursor near the lower end point of Line 4 and click when the cursor changes 
into the Point selection cursor. 

15.	 Click on the Y axis; the preview of the dimension is attached to the cursor.

16.	 Move the cursor downward and click to place the dimension, refer to Figure 3-42.

17.	 Similarly, generate other two dimensions, refer to Figure 3-42.

	 After the dimensions are placed on the sketch, you need to specify their exact values in 
the Details View window.

18.	 Edit the value of the first dimension H6 to 40 in the Details View window; the length 
of the line is changed to 40 mm and is displayed in the Graphics window, refer to 
Figure 3-42.
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19.	 Click on the edit box next to the second dimension L5 and specify the dimensional value 
as 40; the dimension of the line is changed to 40, refer to Figure 3-42.

20.	 Similarly change the dimensional values of V7 and V8 dimensions to 25 and 40, respectively. 
Figure 3-42 shows the final sketch of the cutout feature.

Figure 3-42  Final sketch of the cutout feature

Note
The name of the dimension displayed on the Details View window may be different in your 
system.

21.	 Choose the Modeling tab displayed at the bottom of the Sketching Toolboxes window 
to switch to the Modeling mode; the Tree Outline is displayed.

	 After you exit the Sketching mode, the sketching plane still remains normal to the viewing 
direction. To proceed further with the feature creation operation, it is advised that you 
change the view of the sketching plane to Isometric view.

	
22.	 Right-click in the Graphics window, and then choose the Isometric View option from the 

shortcut menu displayed; the sketch is displayed in the Isometric view.

Tip. You can also click on the ISO ball (cyan color) displayed on the Triad to change 
the view of the sketching plane to the Isometric view. The Triad is displayed at the 
lower right corner of the Graphics window, refer to Figure 3-43.

Figure 3-43  The Triad with the ISO ball 
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	 After the sketch is created, you need to cut the material from the sketch to create the 
cutout feature. You will use the Extrude tool to cut the material. 

23.	 Select Sketch2 from the Tree Outline and then choose the Extrude tool  
from the Features toolbar; the preview of the extruded feature with default 
values is displayed in the Graphics window. Also, a node for the extruded feature with 
the name Extrude2 is added below the Extrude1 node in the Tree Outline.

The default parameters used for generating the preview of the extruded feature are 
displayed in the Details View window. You need to edit values in the Details View window 
to get the desired shape of the cutout.

	 In this tutorial, material should be removed in the normal direction and symmetrically 
from both sides of the sketch.

24.	 Select the Cut Material option from the Operation drop-down list in the Details View 
window, refer to Figure 3-44; the preview of the material to be removed from the existing 
base feature is displayed in the Graphics window.

25.	 Select the Both-Symmetric option from the Direction drop-down list in the Details View 
window, refer to Figure 3-45; the same amount of material is removed from both sides of 
the sketch.

Figure 3-44  Selecting the Cut Material 
option from the Operation drop-down list

Figure 3-45  Selecting the Both-Symmetric option 
from the Direction drop-down list

	 Next, you need to select the method to specify the depth of material removal. 

26.	 Select the Through All option from the Extent Type edit box in the Details View window, 
refer to Figure 3-46.    

The Through All option is used to remove material throughout the model in the specified 
direction. Instead of selecting this option, you can also select the Fixed option and then specify 
the exact depth of material removal, as you did for the base feature.

  
	 Notice the yellow thunderbolt symbol displayed at the upper-right corner of the Extrude 1 

node in the Tree Outline, which indicates that the feature needs to be generated.
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27.	 Next, to complete the process of  material removal, choose the Generate tool  
from the Features toolbar; the cutout feature is created, as shown in Figure 3-47. 
Also, the yellow thunderbolt symbol is changed to green check mark, indicating 
that the feature is updated. 

Figure 3-47  The model after creating the 
cutout

Figure 3-46  Selecting the Through All 
option from the Extent Type drop-down list

Note
In Figure 3-45, the display of plane has been turned off to see the cutout feature clearly.

In the Tree Outline, certain symbols are displayed on the upper right corner of each 
feature node. These symbols and their meanings are given in Table 3-2.

Table 3-2  Various symbols and their meaning

Symbol Meaning

 Green tick mark The feature creation succeeded and can be used for 
further processes.

Yellow thunderbolt mark The feature has been modified and it needs to be 
updated.

Yellow tick mark The feature has been generated, but some warnings 
are associated with it.

Red exclamation mark The feature has failed to generate and you may need 
to redefine the feature.

Blue cross mark The feature is suppressed and has no influence on 
the final model. 

Creating the Blend Feature
	 Next you need to create the blend feature (fillet) with the radius of 10 mm at the sharp 

corners of I-section, refer to Figure 3-11. You will create the fillet on the four edges of 
the model by using the Fixed Radius option from the Blend drop-down in the Features 
toolbar.



3-26					     ANSYS Workbench 14.0: A Tutorial Approach
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

1.	 Choose the Fixed Radius tool from the Blend drop-down in the Features toolbar, refer 
to Figure 3-48;  FBlend1 is attached to the Tree Outline. Also, you are prompted to select 
the edges to be blended.

The Blend tool is used to remove sharp edges in a 3D model. The Fixed Radius option is 
used to create blends with a radius that is constant throughout the edge on which the blend 
is applied. 

2.	 Press the CTRL key and select the four edges of the model, refer to Figure 3-49. You can 
use the tools available in the Graphics toolbar to rotate the model to view its respective 
edges.

Note
To select the edges of a model without rotating it for generating the blend feature, change the 
display mode to wireframe. To change the display of the model to wireframe mode, choose the 
Wireframe option from the View menu. To change the display of the model back to the shaded 
mode, choose the Shaded Exterior and Edges or Shaded Exterior option from the View 
menu.

Figure 3-49  Edges to be selected for creating 
the blend feature

Figure 3-48  Choosing the Fixed Radius 
option from the Blend drop-down

3.	 Choose the Apply button from the Geometry selection box in the Details View window 
to accept the selection of the edges to be blended, as shown in Figure 3-50.

4.	 Enter 10 in the FD1, Radius (>0) edit box to specify the radius of the blend feature.

5.	 Next, choose the Generate tool from the Features toolbar to finish creating  
the blend with the specified radius. The final model after creating the 
blend is shown in Figure 3-51.
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Note
If you select a face for creating blend, all the edges of the selected face will be blended.

Figure 3-51  The model after generating 
the blend feature

Figure 3-50  Choosing the Apply button 
from the Details View window

Rotating the View of the Model Dynamically
	 You can rotate the view of the model dynamically in 3D space so that it can be viewed 

from all directions. This allows you to view all features clearly. 

1.	 Choose the Rotate tool from the Graphics toolbar; the cursor changes into the  
Rotate cursor. Alternatively, right-click in the Graphics window and then choose 
the Cursor Mode > Rotate option from the shortcut menu displayed.

The Rotate tool is used to rotate the view of the model freely in the Graphics window. You can 
invoke this tool from the Graphics toolbar of the DesignModeler window. Like other tools of 
the Graphics toolbar, the Rotate tool is also a transparent tool, implying that the Rotate tool 
can be invoked even when you are using some other tools.

2.	 Next, press and hold the left mouse button and drag the cursor to rotate the model in 3D 
space.

3.	 Choose the Rotate tool from the Graphics toolbar to exit it.

Tip. You can also rotate the view of the model without invoking the Rotate tool. 
To do so, press and hold the middle mouse button in the Graphics window and 
drag the cursor. 

Note
After rotating the model dynamically, you can restore the Isometric view again by clicking on 
the ISO ball (cyan color) in the Triad.

4.	 Exit the DesignModeler window; the Workbench window is displayed.

Note					   
You can close the DesignModeler window even without saving the project. However, in this 
case, the model will be saved automatically but the project will remain unsaved. You need to save 
the project by choosing the Save button from the Standard toolbar of the Workbench window. 
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If the project is saved then its name is displayed on the title bar of the Workbench window. 
Otherwise it will display Unsaved Project on the title bar after closing the unsaved project. 
Also, the model data that was saved automatically will be lost forever.   

Apart from freely rotating the model, you can also view it using the standard orthographic 
projections. To view the model in the orthographic direction, move the cursor over the Triad 
on any axis, the name of the axis will be displayed attached to the cursor. Click on any axis; 
the view will be oriented normal to the selected axis. Move the cursor in the negative direction 
of the three orthogonal axes, the system will display the temporary view of the axis and its 
name with a negative symbol (-). You can also use these negative axes to orient the view of the 
model. Table 3-3 lists the various orthographic views and axes that need to be selected for 
achieving the corresponding view and the shortcut key to get it.

Table 3-3  Various orthographic views and axes that are selected

Orthographic Views Triad Shortcut Key (Num pad)

Right View +X 3

Left View -X 7

Top View +Y 8

Bottom View -Y 2

Front View +Z 1

Back View -Z 9

Default Isometric ISO ball (cyan color) 5

Saving the Project and Exiting ANSYS Workbench
	 After visualizing the model and restoring the default Isometric view, you need to save the 

project and exit ANSYS Workbench. 

1.	 Choose the Save button from the Standard toolbar; the project is saved.	      

2.	 Close the Workbench window to close the ANSYS Workbench session.

Note
1. Instead of creating the I-section with cutout as three separate features, you can create it as 
single feature. To do so, create the sketch as shown in Figure 3-52 and extrude it symmetrically 
by 25 mm on both sides. If the sketch consists of some closed loops inside the outer loop, they will 
automatically be subtracted from the outer loop while extruding.

2. In this tutorial, the model has been created as three separate features to explain the various 
tools and options available in the software. Also, creating the model consisting of various small 
features makes the editing work easier in case any changes are to be made in the design at later 
stages.
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Figure 3-52  The sketch for creating the complete 
model as single feature

    

  

Tutorial 2
In this tutorial, you will create the solid model of the Spring Plate shown in Figure 3-53. The 
dimensions of the model are shown in Figure 3-54. Thickness of the Spring Plate is 2mm. 
Save the project with the name c03_ansWB_tut02 at the location C:\ANSYS_14\c03\Tut02\	 	
  								        (Expected time: 30 min)

Figure 3-53  Model for Tutorial 2 Figure 3-54  Sketch and dimensions for Tutorial 2

  

For the ease of creating the model, the sketch has been divided into small segments, as shown 
in Figure 3-55.

The following steps are required to complete this tutorial:

a.	 Start ANSYS Workbench and add the Geometry component.
b.	 Create the sketch.
c.	 Apply constraints to the sketch.
d.	 Apply dimension to the sketch.
e.	 Extrude the sketch.
f.	 Save the model.
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Figure 3-55  Various entities of the sketch

Starting ANSYS Workbench and Adding Geometry Component System
	 In this section, you need to start ANSYS Workbench and then add a component system 

to the project.

1.	 Choose All Programs > ANSYS 14.0 > Workbench from the start menu; the Workbench 
window is displayed.

Note
If the Getting Started window is displayed along with the Workbench window, you need to 
close it by choosing the OK button.

	 After invoking the Workbench window, you have to add appropriate analysis system or 
the component system to the Project Schematic window. In this tutorial you will create a 
solid model using the Geometry component system.

2.	 Right-click in the Project Schematic window and

Figure 3-56  The Geometry component 
system added to the project

 
choose New Component Systems > Geometry from 
the shortcut menu displayed; the Geometry 
component system is added to the Project 
Schematic window, as shown in Figure 3-56.

By adding the Geometry component system to the 
Project Schematic window, you can have a stand-alone system for the model to be analyzed. 
When any change is made on the geometry using the Geometry component system, the 
changes are displayed in all analysis systems with which the geometry is shared.

Note
A component system can also be added by dragging it from the toolbox and then dropping it in 
the Project Schematic window or by double-clicking on the Geometry option displayed under 
the Component Systems toolbox in the Toolbox window. But in this tutorial, you will use the 
method mentioned in Step 2.
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3.	 Double-click on the name field of the Geometry component system and enter Spring 
Plate to rename it.  

Note
Once the Geometry component system is added to the Project Schematic window, you can 
rename it when the name field gets highlighted at the bottom of the component system in blue. 

4.	 Choose the Save button from the Standard toolbar; the Save As dialog box is 
displayed.

5.	 Browse to the location C:\ANSYS_WB\c03 and then create a sub folder with the name 
Tut02 in the c03 folder.

6.	 Enter c03_ansWB_Tut02 in the File name edit box in the Save As dialog box and then 
choose the Save button in it; the project is saved with the specified name.

Creating the Sketch 
	 After the component system is added to the project, you need to create the sketch for 

the Spring Plate model. To do so, invoke the DesignModeler window and perform the 
following steps to complete the sketch.

1.	 Right-click on the Geometry cell of the Spring Plate component system; a shortcut menu 
is displayed.

2.	 Choose the New Geometry option from the shortcut menu; the DesignModeler window 
along with the ANSYS Workbench dialog box is displayed.

3.	 Select the Millimeter radio button to specify the unit of length and then choose the OK 
button; the dialog box is closed and you are directed to the DesignModeler window to 
proceed with the modeling.

The Millimeter radio button is selected to specify the unit of length as millimeter.

4.	 In the Tree Outline, expand the A: Spring Plate node, if not already expanded; the 
components of the Tree Outline are displayed.

5.	 Select XYPlane from the Tree Outline; the XY plane becomes the active plane.

6.	 Choose the New Sketch tool from the Active Plane/Sketch toolbar; the new entry  
with the name Sketch1 is added under the XYPlane node in the Tree Outline, 
refer to Figure 3-57.

7.	 Right-click on Sketch1 node under the XYPlane node to display a shortcut menu.

8.	 Choose the Look At  tool from the shortcut menu displayed; the sketching plane is  
oriented normal to the viewing direction.
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Figure 3-57  The Tree Outline with 
Sketch1 added to it 

9.	 Choose the Sketching tab from the bottom of the Tree Outline to switch to the Sketching 
mode.

10.	 Next, click on the Draw toolbox to expand it, if it is not already expanded.

11.	 In the Draw toolbox, choose the Line tool; you are prompted to specify the start point of 
the line. Also, the cursor is replaced with Draw cursor. 

12.	 Move the cursor close to the origin; the symbol of Coincident constraint (P) is displayed, 
as shown in Figure 3-58.

13.	 Click on the origin to specify the start point of the line; you are prompted to specify the 
end point of the line.

14.	 Move the cursor upward along the axis such that the symbol of Vertical constraint (V) is 
displayed along the path of the cursor. Move the cursor to some distance along the Y axis 
and then click to specify the end point of line, as shown in Figure 3-59. The line is created 
and  is displayed in blue color indicating that it is fully constrained.

	

Figure 3-58  Specifying the start point of the 
line

Figure 3-59  Specifying the end point of the 
line

	 After Line 1 is created, you now need to create the arc, Arc 1 (refer to Figure 3-55 for 
naming conventions used in this tutorial).

15. Now, invoke the Arc by Tangent tool from the Draw toolbox.



Part Modeling - I	  3-33

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

The Arc by Tangent tool is used to create an arc tangent to a line. Choose the Arc by Tangent 
tool from the Draw toolbox and specify a point on any existing sketched entity, the arc to be 
created will maintain tangency with the specified point. Also, the symbol of Tangent constraint 
(T) is displayed when you move the cursor close to the line. Next, specify the second point to 
define the end point of the arc.

16.	 Move the cursor close to end point of Line 1; the symbol of Point Coincident (P) is displayed. 
Next, click to specify the start point for arc 1, as shown in Figure 3-60.

17.	 Move the cursor toward right to some distance and click to specify the end point of arc 
1; the arc is created, as shown in Figure 3-61.

Note
In case the arc is created in a direction opposite to the desired direction, right-click to display a 
shortcut menu and then choose Reverse from it.

Figure 3-60  Specifying the start point of the 
arc

Figure 3-61  Specifying the endpoint of the 
arc

18.	 Now you need to create a line tangent to the arc 1. Invoke the Tangent Line tool from the 
Draw toolbox and move the cursor close to the end point of arc 1; the symbols of Tangent  
constraint (T) and the Point Coincident constraint (P) are displayed. Click to specify the 
start point of the line 2, as shown in Figure 3-62.

19.	 Specify the end point for line 2, as shown in Figure 3-63.

Figure 3-62  Specifying the startpoint of the 
line

Figure 3-63  Specifying the endpoint of the 
line
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You can create a tangent line by using the Tangent Line and Line by 2 Tangents tools. To 
create a tangent line using the Tangent Line tool, choose this tool from the Draw toolbox; 
the cursor will change to the Draw cursor. Next, select a curved sketch; the preview of the line 
will be displayed attached to the Draw cursor. Next, specify the end point of the line to define 
the length of the line, refer to Figure 3-61. You can also create lines by using the  Line by 2 
Tangents tool. To do so, invoke this tool from the Draw toolbox and select two existing curve 
sketched entities; the tangent line will be created. In case more than one tangent locations are 
available on the selected entities, the tangent line will be generated using the tangent location 
nearest to the point of selection.

Note
The lines created using the Tangent Line tool may not always be vertical. They can be made 
vertical by applying Vertical constraints.

	 Now, you need to create an arc.

20.	 Invoke the Arc by Tangent tool from the Draw toolbox of the Sketching tab; you are 
prompted to specify the start point of the arc 2.

21.	 Move the cursor close to the end point of line 2; the symbol of Coincident constraint (P) 
sign is displayed. Click to specify the start point of arc 2, as shown in Figure 3-64.

22. Move the cursor to the right till the symbol of Equal Radius constraint (R) is displayed. 
Then click to specify the end point of arc 2; arc 2 is created, as shown in Figure 3-65.

Figure 3-64  Specifying the start point of the 
arc

Figure 3-65  Specifying the end point of the 
arc

	 Now you need to draw the line 5. 

23.	 Invoke the Tangent Line tool from the Draw toolbox; you are prompted to specify the 
start point of line. Move the cursor close to the end point of arc 2 and click to specify the 
start point of line 3 when the symbols of Tangent constraint (T) and Point Coincident 
constraint (P) are displayed, as shown in Figure 3-66.

24.	 Move the cursor upward to some distance. While moving the cursor, the symbol of Vertical 
constraint (V) is displayed along with the preview of the line. Click to specify the end point 
of line 3, as shown in Figure 3-67.
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25.	 Next, invoke the Arc by Tangent tool; you are prompted to select a 2D edge or end point 
of a line.

Figure 3-66  Specifying the start point of the 
line 3

Figure 3-67  Specifying the endpoint of the 
line 3

26.	 Select the end point of line 3, as shown in Figure 3-68; you are prompted to specify the 
end point of arc 4.

27.	 Move the cursor toward right till the symbol of Equal Radius constraint (R) is displayed. 
Click to specify the end point of arc 4, as shown in Figure 3-69.

Figure 3-68  Specifying the startpoint of the 
arc 4

Figure 3-69  Specifying the endpoint of the 
arc 4

	 Next, you need to draw the line 4 and arc 4 to finish the sketch. 

28.	 Invoke the Tangent Line tool from the Draw toolbox; you are prompted to specify the 
start point of the line.

29.	 Move the cursor close to end point of arc 3; the symbols of Tangent constraint (T) and 
the Point Coincident constraint (P) are displayed attached to the cursor.

30.	 Select the end point of arc 3 to specify it as the start point of line 4, as shown in Figure 3-70. 
Also, you are prompted to specify the end point of line 4.

31.	 Move the cursor downward; the preview of the line will be displayed. Also, the symbol 
of Vertical constraint ( V ) gets attached to the preview. After moving the cursor to some 
distance, click to specify the end point of line; line 4 is drawn, as shown in Figure 3-71.
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Figure 3-70  Specifying the start point of the 
line

Figure 3-71  Specifying the endpoint of the 
line

	 Now, you need to draw the arc 4 to complete the sketch. Note that the arc to be drawn 
should be made with an angle of 270 degrees.

32.	 Invoke the Arc by Tangent tool from the Draw toolbox; you are prompted to select an 
edge or end point of line to specify the start point of arc. Select the end point of line 4 as 
the start point of arc 4, as shown in Figure 3-72.

33.	 Next, move the cursor toward right and then create an arc similar to the one shown in 
Figure 3-73.

Figure 3-72  Specifying the start point of arc 4 Figure 3-73  Final sketch after the arc 4 is drawn

Applying Constraints to the Sketch
	 After the sketch is drawn, you need to apply constraints to the entities. 

1.	 Expand the Constraints toolbox from the Sketching Toolboxes window.

2.	 Choose the Equal Length tool from the Constraints toolbox; you are prompted to select 
the first line on which Equal Length constraint is to be applied.

The Equal Length tool is used to force two linear entities to maintain the same length.

3.	 Select line 2; you are prompted to select second line for equal constraint.

4.	 Select line 3; line 2 and line 3 become equal in length.
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5.	 As the Equal Length tool is still active, select line 3 and then line 4; both the lines become 
equal in length.

	 Now you need to apply the Equal Radius constraint between all the arcs.

6.	 Choose the Equal Radius tool from the Constraints toolbox; you are prompted to select 
the first arc or circle to apply the constraint.

The Equal Radius tool is used to force two circular entities to become equi-radius. 

7.	 Select arc 1; you are prompted to select the second arc to apply the Equal Radius constraint.

8.	 Select arc 2; arcs 1 and 2 become equal in radius.

9. 	 Similarly, apply the Equal Radius constraint between arcs 2 and 3 and then between arcs 
3 and 4; all the arcs become equal in radius.

Assigning Dimensions to the Sketch
	 After the sketch is drawn and the constraints are applied, you need to assign dimensions 

to the entities. 

1.	 Choose the General tool from the Dimensions toolbox; you are prompted to select a 2D 
edge or line that you want to dimension.

2.	 Select line 1; the shape of the cursor changes to Draw cursor. Also, the preview of the 
dimension is attached to the cursor.

3.	 Click on the left of line 1 to place the dimension, as shown in Figure 3-74. 

4.	 Place all other dimensions to their respective places, as shown in Figure 3-75.

Figure 3-74  Placing the dimension of line 1 Figure 3-75  Sketch after all the dimensions 
are placed

	 You need to place only three dimensions in the sketch, remaining dimensions will be 
applied automatically as the Equal Radius and Equal Length constraints have been applied 
to them earlier in this tutorial. After the dimensions are placed, you need to assign values 
to each of them. 
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5.	 Choose the Modeling tab located at the bottom of the Sketching Toolboxes window; the 
Modeling mode becomes active.

6.	 Expand the XYPlane node in the Tree Outline, if not already expanded.

7.	 Select Sketch1 under the expanded XYPlane node; the corresponding Details View 
window is displayed.

8.	 In the Details View window, expand the Dimensions node if not already expanded. 

The Dimensions node in the Details View window displays the dimensions that are placed 
on the sketch in the Graphics window. 

9.	 Click on the R1 edit box in the Details View window and enter 5; the radius of all arcs is 
changed to 5 mm instantaneously.

Note
When you click on any edit box under the Dimensions node in the Details View window, the 
corresponding dimension in the Graphics window is highlighted in yellow color.

10.	 Next, click on the V1 edit box and then enter 50; the length of Line1 is changed.

11.	 Similarly, modify dimension V2 to 30. 

	 Figure 3-76 shows the Dimensions node of the Details View window.

Figure 3-76  The Dimensions node in the Details View window

Creating the Extrude Feature 
	 After the sketch is fully constrained and dimensions are applied, you now need to add 

material to the sketch. This is done by using the Extrude tool. 

1.	 Choose the Extrude tool from the Features toolbar; Extrude1 is attached to the Tree 
Outline. Also, the preview of extrusion is displayed in the Graphics window.

2.	 Click on the ISO ball available on the bottom right corner of the Graphics window; the view 
is changed to isometric. Figure 3-77 shows the ISO ball with the Triad and Figure 3-78 shows 
the Isometric view of the model.
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Figure 3-77  The Triad with the ISO ball Figure 3-78  The Isometric view of the model

	 Now, you need to set the parameters for extrusion. The parameters of extrusion are set 
in the Details View window. 

3.	 Select Geometry in the Details View window to display the Apply and Cancel buttons, 
if not already displayed.

4.	 Choose the Apply button in the Geometry selection box to specify the sketch as the sketch 
to be extruded.

5.	 In the Operations drop-down list in the Details View window, select Add Material if it is 
not already selected.

6.	 In the Directions drop-down list, select Both - Symmetric; the material is added to both 
sides of the plane.

7.	 In the FDI, Depth (>0) edit box, enter 10 as the depth of extrusion. 

8.	 In the As Thin/Surface? drop-down list, select Yes; the FD2, Inward Thickness (>0) and 
FD3, Outward Thickness (>0) edit boxes are activated.

The Thin/Surface tool is used to create surface out of sketches or create shell features in 
models. 

9.	 Click on the FD2, Inward Thickness (>0) edit box and enter 1 as the value of thickness 
in the inward direction.

10.	 Click on the FD2, Outward Thickness (>0) edit box and enter 1 as the value of thickness 
in the outward direction.

11.	 After specifying all the parameters in the Details View window, choose  
the Generate tool from the Features toolbar; the geometry is extruded, 
as shown in Figure 3-79. 
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	 The final model for Tutorial 2 is shown in Figure 3-80. The axes and the sketch have been 
turned off for a better visibility.

Figure 3-79  The generated feature Figure 3-80  The final model for Tutorial 3

12.	 Close the DesignModeler window; the Workbench window is displayed.

Saving the Model
	 After the model is created, you now need to save your work.

1.	 Choose the Save button from the Standard toolbar to save the model.

2.	 Exit the Workbench window.

Tutorial 3
In this tutorial, you will create the solid model of the clamp shown in Figure 3-81. The 
sketch of the model and its dimensions are shown in Figure 3-82. Save the project with the 
name c03_ansWB_tut03 at the location C:\ANSYS_WB\c03\Tut03. (Expected time: 30 min)

Figure 3-81  Model for Tutorial 3
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Figure 3-82  Dimensions of the clamp

	 The following steps are required to complete this tutorial:

a.	 Start ANSYS Workbench 14.0.
b.	 Add the Geometry component system to the project.
c.	 Start DesignModeler window and specify unit system.
d.	 Draw the sketch for the base feature on the XYPlane.
e.	 Create the base feature.
f.	 Create the circular cutout.
g.	 Create the blend feature.
h.	 Save the project and exit the ANSYS Workbench session.

Starting ANSYS Workbench and Adding Geometry Component System
	 First, you need to start ANSYS Workbench 14.0 and then add a component system to the 

project. 

1.	 Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu; the 
Workbench window along with the Getting Started window is displayed.

2.	 Choose the OK button in the Getting Started window to close it. 

	 After invoking the Workbench window, you have to add appropriate analysis system or 
a component system to the Project Schematic window. In this tutorial, you will create a 
solid model using the Geometry component system. 

3.	 Right-click in the Project Schematic window and choose New Component Systems > 
Geometry from the shortcut menu displayed, as shown in Figure 3-83; the Geometry 
component system is added to the project and is displayed in the Project Schematic 
window.
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Figure 3-83  Choosing the Geometry option from the shortcut menu displayed 
on choosing the New Component System option

4.	 Once the Geometry component system is added to

Figure 3-84  The Geometry component 
system added to the project

 
the Project Schematic window, the name field at 
the bottom of the component system is highlighted 
in blue. If it is not highlighted, double-click on the 
name field and enter Clamp, refer to Figure 3-84. 
The component system is renamed as Clamp.

	 The blue question mark on the right of the Geometry cell indicates that an immediate 
action is required for this cell and the user cannot proceed further without fixing this cell. 

5.	 In the Workbench window, choose the Save button from the Standard toolbar; the Save 
As dialog box is displayed.

6.	 Browse to the location C:\ANSYS_WB\c03 and then create a sub folder with the name 
Tut03 in the c03 folder and then choose the Open button from the Save As dialog box.

7.	 Enter c03_ansWB_Tut03 in the File name edit box in the Save As dialog box and then 
choose the Save button in it; the project is saved with the specified name.

Starting DesignModeler Window and Specifying Unit System
	 To define the geometry, you need to start the DesignModeler window associated with this 

cell. 

1.	 Double-click on the Geometry cell in the Clamp component system; the  
DesignModeler window along with the ANSYS Workbench dialog box 
is invoked. 
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The ANSYS Workbench dialog box is used to specify the unit system for creating the 
model. 

Note
You can also invoke the DesignModeler window by choosing the New Geometry option from 
the shortcut menu that is displayed by right-clicking on the Geometry cell of an analysis system 
or component system.

2.	 Choose the Millimeter radio button and then choose the OK button from the ANSYS 
Workbench dialog box to accept the specified unit system.

Drawing the Sketch for the Base Feature
	 You need to create the sketch for the base feature on the XY plane which is the default 

plane. Therefore, you need not specify the plane. 

1.	 Choose the Sketching tab displayed in the lower left corner of the Tree Outline to invoke 
the Sketching mode.

Note
1. To select a plane other than the default plane (XY), select it from the New Plane drop-down 
list in the Active Plane/Sketch toolbar.  

2. To insert a sketch instance or create a new sketch on a plane other than the default plane, you 
can right-click on the plane node in the Tree Outline to display a shortcut menu. Next, choose 
Insert Sketch Instance from it; a sketch instance will be displayed under the desired node.

	 Now, you need to orient the sketching plane normal to the viewing direction, so that  
you can easily draw the sketch on the specified plane. 

2. 	 Choose the Look At tool from the Graphics toolbar to orient the model normal to the 
viewing direction.

Note
You can also orient a plane normal to the viewing direction by choosing the Look At tool from 
the shortcut menu displayed on right-clicking on the sketch instance. 

3.	 Choose the Circle tool from the Draw toolbox; you are prompted to specify  
the center of the circle.

In DesignModeler, you can draw circles by using two different methods. In the first method, 
specify the center point of the circle and then define its radius. In the second method, you 
need to specify the three existing drawing entities in the Graphics window with which the 
new circle to be created must maintain the tangency relation. This type of circle is known as 
tri-tangent circle. You can choose any of the two methods for drawing circles.
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4.	 Move the cursor close to the origin in the Graphics window and click; the symbol  of 
Coincident Point constraint (P) is displayed. After specifying the center point of the circle, 
the preview of the circle is displayed attached to the Draw cursor. Also, you are prompted 
to specify the radius of the circle.

5.	 Move the cursor away from the center and click; a circle is created, as shown in 
Figure 3-85.

6.	 Press the ESC key to exit the Circle tool.

	 After creating the first entity of any sketch, it is better to generate its dimensions first. 
This gives you a fair idea about the graphics space required to complete the sketch. Also, 
it helps you decide the comparative size of other sketched entities to complete the outer 
profile. Now, you will generate the radius dimension of the circle that you created in the 
previous step and change its value to 50mm.

7.	 Expand the Dimensions toolbox in the Sketching Toolboxes window.

8.	 Choose the Radius tool from the Dimensions toolbox; you are prompted to select the 
entity to place the dimension.

The Radius tool is used to generate dimensions for circles, arcs, or ellipses. When you select 
an arc for dimensioning, the radius dimension is generated, and when you select an ellipse, 
the major and minor dimensions are generated.

9.	 Move the cursor over the circle and select it; the preview of dimension is attached with 
the cursor.

10.	 Move the cursor away from the circle and click to place the dimension. The dimension is 
generated and its name is displayed on the dimension line.

	 Other details of the dimension are displayed in the Details View window. 

11.	 In the Details View window, click in the edit box displayed on the right of the dimension 
name (R1) under the Dimensions: 1 node.

Note
The name of the dimension displayed on the dimension line can be different in different systems. 
To avoid such confusion and to facilitate the proper explanation, refer to the corresponding 
screen captures of the dimensions.

12.	 Enter 50 in this edit box and press the ENTER key; the radius of circle changes to 50 mm 
and is displayed in the Graphics window, refer to Figure 3-86.
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Now, you need to complete the remaining part of sketch for the base feature.

Figure 3-85  Specifying the radius of the 
circle

Figure 3-86  The circle after editing the 
dimension value

13.	 Click on the Modify toolbox in the Sketching Toolboxes window; the Modify toolbox 
expands.

The Modify toolbox contains various tools such as Fillet, Chamfer, Trim, Extend, Split, and 
so on. These tools are used to edit sketched entities in the Sketching mode.

14.	 Scroll down the Modify toolbox to display other tools, refer Figure 3-87.  
Next, choose the Offset tool from the Modify toolbox; you are prompted to 
select the line or arc to offset.

The Offset tool is used to draw multiple parallel lines, parallel polylines, concentric circles, 
concentric curves, concentric arcs, and so on. When you choose the Offset tool from the 
Modify toolbox, you will be prompted to select the entities to be offset. The entities selected 
for offsetting must be connected end to end and should form open or closed profile.  

15.	 Select the circle and right-click in the Graphics window; a shortcut menu is displayed.

16.	 Choose the End selection / Place offset option from the shortcut menu; the preview of 
the entity to be offset is displayed attached to the cursor.

Note
If you have made a wrong selection by mistake, then choose the Clear Selection option from the 
shortcut menu and select again the correct entity to be offset.

17.	 Move the cursor inside the circle and click to specify an offset distance, refer to 
Figure 3-88.

 
18.	 Right-click in the Graphics window and choose the End option from the shortcut menu 

displayed; the Offset tool is deactivated.

After editing the sketch, if you want to exit the current selection and select other entity to 
offset, choose the Clear Selection option from the shortcut menu.
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Figure 3-88  Specifying the offset distanceFigure 3-87  Tools in the Modify toolbox 

	 After the circular entities are created, you need to create the linear entities.

19.	 Expand the Draw toolbox and invoke the Polyline tool; you are prompted  
to specify the start point of the line.

You need to define the start point and end point of the line, each time you want to create a 
line using the Line tool. But if you want to create a continuous connected line where the start 
point of the next line is automatically defined as the end point of the previous line, choose 
the Polyline tool from the Draw toolbox. Specify the start and end points of the first line; 
the first line will be created and the preview of another line whose start point is the end point 
of the first line will be attached to the Draw cursor. Specify the third point; the second line 
will be created and the preview of the third line whose start point will be the end point of the 
second line will be displayed attached to the Draw cursor. Keep on specifying the points to 
create continuous lines. To stop creating the polyline and exit the Polyline tool, right-click in 
the Graphics window and choose the Open End option from the shortcut menu.

20.	 Move the cursor near the circumference of the outer circle and click when the symbol of 
Coincident constraint (C) is displayed, refer to Figure 3-89.

21.	 Move the cursor toward left and click to draw a horizontal polyline. 

22.	 Draw the vertical second entity of the polyline and then draw the horizontal third entity 
of the polyline. Make sure that the end point of the third entity is coincident with the 
inner circle, refer to Figure 3-90.

23.	 After drawing the three entities of the polyline, right-click in the Graphics window and 
choose the Open End option from the shortcut menu displayed.

24.	 Press the ESC key to exit the Ployline tool.
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Figure 3-89  Creating the first entity of the 
polyline

Figure 3-90  Sketch after creating the third 
entity of the polyline

	 Next, you need to create a similar sketch on the other side of the X axis such that this 
sketch becomes the mirror copy of the sketch already created.

25.	 Expand the Modify toolbox and choose the Replicate tool; you are  
prompted to select points or edges to replicate.

The Replicate tool is used to copy entities from an existing sketch and paste them wherever 
required.

26.	 Select the three entities of the polyline created in the previous steps and right-click in the 
Graphics window; a shortcut menu is displayed, as shown in Figure 3-91.

27.	 Choose the End / Use Plane Origin as Handle option from the shortcut menu, refer to 
Figure 3-91; the preview of the entities to be replicated along with the paste handle is 
displayed, refer to Figure 3-92.

 
The paste handle is used to set a reference point while replicating entities. This reference 
point is used while placing the entities to be replicated. To replicate the entities, select the 
entities and then right-click to display a shortcut menu. This shortcut menu contains options 
such as Clear Selection, End/Set Paste Handle, End/Use Plane Origin as Handle, and End/
Use Default Paste Handle. 

The Clear Selection option is used to deselect the entities that were selected to replicate earlier. 
The End / Set Paste Handle option is used to specify the paste handle by specifying a point 
in the Graphics window. The End / Use Plane Origin as Handle option is used to specify the 
origin of the sketching plane as the paste handle. The End / Use Default Paste Handle 
option is used to specify a system specified point of the selected entity as the paste handle.

	 Since the entities to be replicated are the mirror copies of the selected entities, you have 
to flip them about the X axis. 
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Figure 3-91  The shortcut menu displayed 
while the Replicate tool is active

Figure 3-92  Preview of the entities to be 
replicated and the paste handle

28.	 Next, select the origin; you are prompted to specify the location to paste the entities, as 
shown in Figure 3-93.

29.	 Right-click in the Graphics window and choose the Flip Vertical option from the shortcut 
menu displayed, refer to Figure 3-92; the preview of the flipped entity is displayed, as 
shown in Figure 3-93 displayed. 

After specifying the location of paste handle, instead of replicating the entities directly, you 
can rotate them by the desired angle, scale them by desired scale factor, and flip them along 
the horizontal and vertical directions. Place the entities at the desired locations, by using the 
options from the shortcut menu.

To rotate the selected entities before replicating them, enter the required angle of rotation in 
the r edit box, displayed on the right of the Replicate tool. Right-click in the Graphics window 
to display the shortcut menu, refer to Figure 3-94. Next, choose the Rotate by r Degrees or 
Rotate by -r Degrees option from the shortcut menu.

To scale the selected entities before replicating them, enter the required value for scale factor 
in the f edit box, displayed on the right of the Replicate tool. Next, choose the Scale by 
factor f or Scale by factor 1/f option from the shortcut menu according to the requirement, 
refer to Figure 3-94.

30.	 Move the paste handle to the origin and click when the symbol of Coincident Point 
constraint (P) is displayed, refer to Figure 3-95; the mirror copies of the selected entities 
are replicated at their required locations, refer to Figure 3-96.
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Figure 3-93  Specifying the location of paste 
handle

Figure 3-94  Specifying the option to flip the 
entities vertically

Figure 3-96  The sketch after replicating the 
selected entities

Figure 3-95  Preview of the entities to be 
replicated after flipping them vertically

31.	 Press the ESC key to exit the Replicate tool.

Next, you need to trim the unwanted portion of the sketch using the Trim tool from the 
Modify toolbox.

32.	 Choose the Trim tool from the Modify toolbox; you are prompted to select 
edges to trim.

The Trim tool is used to trim the objects that extend beyond a required point of intersection. 
While creating a sketch, there are a number of places where you need to remove the unwanted 
and extending edges. Choose the Trim tool from the Modify toolbox; the Draw cursor will 
be displayed and you will be prompted to select the edges to be trimmed. Select the sketched 
entity to be trimmed; the selected sketched entity is trimmed to its nearest point of intersection 
with any other sketched entity or axis.

33.	 Select the Ignore axis check box displayed on the right of the Trim tool and click on the 
segments one by one, marked in Figure 3-97; the selected segments is trimmed and you 
get the sketch shown in Figure 3-98.
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The Ignore axis check box is selected to ignore the intersection of the segment of circles with 
the X axis while trimming. 

Figure 3-97  Segments of the circle to be 
trimmed

Figure 3-98  Sketch after trimming the 
entities

Applying Geometric Constraints and Dimensions to the Sketch
	 The entities of the sketch should be fully specified in terms of size, shape, orientation, 

and location. This is achieved by setting geometric constraints and dimensions. 

Geometric constraints are the logical operations that are performed to add relationship (such 
as tangent or perpendicular) between the sketched entities, planes, axes, edges, or vertices. 
The constraints applied to the sketched entities are used to capture the design intent. By 
using constraints in a sketch, you can reduce the number of dimensions that are required in 
that sketch. The geometric constraints are applied using the tools available in the Constraints 
toolbox.

1.	 Expand the Constraints toolbox and choose the Equal Length tool  
from it; you are prompted to select lines to apply the constraints.

2.	 Select any one of the two vertical lines from the sketch; you are prompted to select the 
lines to apply the Equal Length constraint.

3.	 Select the second vertical line from the sketch; the Equal Length constraint is applied to 
the two vertical lines and you are prompted to select the first line for applying the Equal 
Length constraint. 

4.	 Select the top most horizontal line of the sketch and then select the bottom most horizontal 
line of the sketch to make them equal in length.

5.	 Select the Symmetric tool from the Constraints toolbox; you are prompted  
to specify the axis of symmetry. Select the X axis; you are prompted to 
select a point or edge to apply the Symmetric constraint.
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The Symmetric tool is used to make entities symmetric about a centerline. After this tool is 
invoked, select a centerline and then select the entities which are to be made symmetric.

6.	 Select the horizontal line from the sketch that is just above the X axis; you are prompted 
to select the second point or edge to apply the Symmetric constraint.

7.	 Select the horizontal line from the sketch that is just below the X axis; the two horizontal 
lines become symmetric about the X axis.

8.	 Choose the Concentric tool from the Constraints toolbox and select the  
two circular arcs from the sketch; the selected arcs become concentric.

The Concentric tool is used to force two circular entities share the same center.

	 Next, you need to generate the dimensions and edit their values to get the sketch of 
desired size.

9.	 Expand the Dimensions toolbox from the Sketching Toolboxes windows  
and then choose the General tool.

10.	 Generate all dimensions shown in Figure 3-99 and edit the value of dimensions in the 
Details View window, refer to Figure 3-100.

Figure 3-99  Dimensions to be generated for 
the sketch of base feature

Figure 3-100  Value of dimensions in the 
Details View window

     

Note
The names of the dimensions displayed in the Details View window can be different in your 
system.

	 After applying the required geometric constraints and generating the dimensions, the 
color of the sketch will change to blue indicating that the sketch is fully constrained and 
is ready to be used for feature creation operations.

	 After completing the sketch, you need to exit the Sketching mode. 
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11.	 Choose the Modeling tab located at the bottom of the Sketching Toolboxes window; the 
Sketching mode is activated and the Tree Outline is displayed. Also, Sketch 1 is added 
under the XYPlane node.

	 After exiting the Sketching mode, the sketching plane is still normal to the viewing 
direction. To proceed further with the feature creation operation, it is advised to change 
the view of the sketching plane to Isometric view. 

12.	 Right-click in the Graphics window, and then choose the Isometric View option from the 
shortcut menu displayed; the sketch is displayed in Isometric view.

Creating the Base Feature 
	 Next, you need to create the base feature using the Extrude tool from the Features 

toolbar.  

1.	 Choose the Extrude tool from the Features toolbar; the preview of the  
extruded feature with the default values is displayed in the Graphics window. 
Also, a node for the extruded feature with the name Extrude 1 is added below the three 
default planes in the Tree Outline.

The default parameters used for generating the preview of the extruded feature are displayed 
in the Details View window. To get the required shape of the base feature, you need to edit 
the values in the Details View window.

	 As per the requirement of this tutorial, the material should be added normal to and 
symmetrically on both sides of the sketch. 

2.	 Select the Both-Symmetric option from the Direction drop-down list. 

3.	 Enter 10 in the FD1, Depth (>0) edit box of the Details View window. 

	 The complete depth of material addition is 20mm, but the material will be added 
symmetrically by the same depth on both the sides of the sketch. Therefore, 10mm is 
specified as the depth value.

4.	 Choose the Generate  tool from the

Figure 3-101  The base feature

 
DesignModeler toolbar; the base feature is 
created with the specified settings, refer to 
Figure 3-101.

By default, the sketch is displayed only when the 
plane on which it is created is the active plane. 
Since the XY plane is the current active plane, 
the sketch and the dimensions of the Sketch1 are 
still displayed in the Graphics window. You can 
hide the sketch as  the sketch and its dimensions 
are not needed now.
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5.	 Right-click on the Sketch1 in the Tree Outline and choose the Hide Sketch option from 
the shortcut menu displayed. 

Note
If needed, you can again display the sketch and its dimensions. To do so, right-click on the Sketch1 
in the Tree Outline and choose the Show Sketch option from the shortcut menu displayed.  

Creating the Circular Cutout
	 Next, you need to create the circular cutout on

Figure 3-102  Selecting the flat face for 
defining the Sketching plane

 
the two rectangular flanges of the base feature. 
The sketch for this feature should be created 
on the rectangular flange. As the three default 
planes do not pass through the surface on 
which the cutout has to be created, these 
planes cannot be used for drawing the sketch. 
Therefore, you have to define a new plane on 
the top flat face of the rectangular flange and 
draw the sketch for the circular cutout.

1.	 Select the top face of the rectangular flange, refer to Figure 3-102.  

You can use the tools available in the Select toolbar to select an edge, face, vertex, and so on 
in a geometry, refer to Figure 3-103. For example, the Edge tool is used to select an edge, the 
Face tool is used to select a face, and so on. Alternatively, right-click in the Graphics window to 
display a shortcut menu and then choose the desired tool from the Selection Filter cascading 
menu, as shown in Figure 3-104.

2.	 Choose the New Plane tool from the Active Plane/Sketch toolbar; Plane4 is added  
to the Tree Outline.

3.	 Choose the Generate tool available in the Features toolbar to generate the  
new plane. 

Figure 3-104  Choosing a selection mode from 
the  Selection Filter cascading menu

Figure 3-103  The Select toolbar
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4.	 Choose the Sketching tab available under the Tree Outline; the Sketching mode is 
invoked.

5.	 Choose the Look At  tool from the Graphics toolbar.  			          

The Look At tool is used to orient the view normal to the screen.

6.	 Choose the Circle tool from the Draw toolbox and draw a circle as shown in  
Figure 3-105.

7.	 Expand the Dimensions toolbox. The General tool is chosen by default in this toolbox.

8.	 Generate the dimensions of the circle and specify their values in the Details View window, 
refer to Figure 3-106. The sketch gets fully-defined and is ready to be used for feature 
creation.

Figure 3-105  Creating circle on the defined 
sketching plane

Figure 3-106  Generating the dimensions of 
the sketch for cutout feature

9.	 Invoke the Modeling mode by choosing the

Figure 3-107  The new plane and sketch 
added in the Tree Outline  

 
Modeling tab displayed below the Sketching 
Toolboxes window. The sketch of the cutout 
feature is created on Plane4 and is displayed as 
Sketch2 in the Tree Outline, as shown in 
Figure 3-107.

10.	 Change the view to isometric by clicking on the 
ISO ball (cyan color) of the Triad, displayed 
at the bottom right corner of the Graphics 
window.

	 After drawing the sketch, you need to remove the material from the base feature using 
the Extrude tool.

11.	 Choose the Extrude tool from the Features toolbar; the preview of the  
extruded feature with the default values is displayed in the Graphics 
window.
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 Also, the Tree Outline is activated and Extrude2 is added below Extrude1 in the Tree 
Outline.

12.	 Select the Cut Material option from the Operation drop-down list. 

The Cut Material option is used to create cutouts, holes, and so on in an existing 
components.

	 As per the design requirements, the material should be removed starting from the flat face 
on which the sketch is created and up to the bottom most face of the second rectangular 
flange. 

13.	 Select the To Surface option from the Extent Type drop-down list, refer to Figure 3-108; 
the Target Faces selection box is added in the Details View window.

To extrude a sketch to a desired face of an existing model, choose the To Surface option.

14.	 Click on the Target Faces selection box; the Apply and Cancel buttons are displayed in 
the Target Faces selection box and you are prompted to select faces to create extrude.

15.	 Select the bottom face of the second flange, refer to Figure 3-109; the material is removed 
up to the specified surface.

Note
While selecting the target face, you need to rotate the view of the model. The process of dynamically 
rotating the model has been discussed in detail in the previous tutorial. 

16.	 Choose the Apply button from the Target Face selection box to accept the specified 
face.

17.	 Choose the Generate tool from the Features toolbar; the cutout feature is 
created, refer to Figure 3-110.

Figure 3-108  Selecting the To Surface 
option from the Extent Type drop-down 
list in the Details View window

Figure 3-109  Specifying the face up to 
which the material will be removed



3-56					     ANSYS Workbench 14.0: A Tutorial Approach
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Creating the Blend Feature
	 To remove the sharp edges from the clamp, you need to create fillets of radius 5 mm at 

the vertical edges of the clamp. The fillet will be created on four vertical edges of the 
model using the Fixed Radius option of the Blend tool.

1.	 Choose the Fixed Radius tool from the Blend drop-down in the Features  
toolbar; you are prompted to select edges to blend.

2.	 Press the CTRL key and select the four vertical edges of the model, refer to 
Figure 3-111. 

Note
1. In Figures 3-110 and 3-111, the display of planes has been turned off for better visualization. 
As per the need, you can turn on or off the display of planes by choosing the Display Plane 
button from the Graphics toolbar.

2. To facilitate the selection of edges without rotating the model and for generating the blend 
feature, change the display mode to wireframe. The procedure to change the display mode has 
been discussed in the previous tutorial.

3.	 Click on the Geometry selection box in the Details View window; the Apply and Cancel 
buttons are displayed. Next, choose the Apply button from the Details View window to 
accept the selected of edges to be blended.

4.	 Enter 5 in the FD1 Radius (>0) edit box as the radius of the edit box.

5.	 Choose the Generate tool from the Features toolbar; the blend feature is  
created. Figure 3-112 shows the final model.

Figure 3-111  Edges to be selected for creating 
the blend feature

Figure 3-110  Model after creating the 
circular cutout
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Figure 3-112  The final model

   

Tip. Even after creating a feature, you can modify some of its parameters. To do so, 
select the feature that you need to modify from the Tree Outline; the parameters of 
the selected feature will be displayed in the Details View window. The parameters 
that cannot be edited will be grayed out and the remaining parameters can be edited. 
Change the value of the required parameters and then choose the Generate button 
from the Features toolbar. 

6.	 Close the DesignModeler window; the Workbench window is displayed.

Saving the Project and Exiting ANSYS Workbench
	 After visualizing the model and restoring the default Isometric view, you need to save the 

project and exit ANSYS Workbench. This saved project will be used in later chapters for 
analysis.

1.	 In the Workbench window, choose the Save button from the Standard toolbar; the  
project is saved with the name c03_ansWB_tut03. 

2.	 Choose File > Exit from the Workbench window to exit the ANSYS Workbench 
session.

 Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this  
chapter:

1.	 In the DesignModeler window, the P symbol represents the Coincident Point constraint. 
(T/F)

2.	 The Extrude tool can be invoked from the Create menu of the Menu bar. (T/F)

3.	 In the DesignModeler window, none of the constraints are automatically applied while 
drawing a sketch. (T/F)



3-58					     ANSYS Workbench 14.0: A Tutorial Approach
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

4.	 The Horizontal tool in the Constraints toolbox can be used to make a linear entity 
horizontal. (T/F)

5.	 You can change the view type to isometric by using the ISO ball present in the Triad. 
(T/F)

6.	 You can switch to the Modeling mode by choosing the Modeling tab available at the 
bottom of the Sketching Toolboxes window. (T/F)

7.	 The Arc by Tangent tool can be invoked from the ___________ toolbox.

8.	 The __________ tool is used to make two entities equal in length.

9.	 You can invoke the Offset tool from the _________ toolbox.

10.	 You can hide or show a sketch anytime by using the _____________________.

 Review Questions
Answer the following questions:

1.	 The options in the Details View window are contextual in nature. (T/F)

2.	 You can create patterns of entities by using the Replicate tool available in the Modify 
toolbox. (T/F)

3.	 You can change the direction of extrusion by using the options in the Direction drop-down 
list in the Details View window. (T/F)

4.	 On choosing any tool from the Draw toolbox, the normal arrow cursor changes to Draw 
cursor. (T/F)

5.	 Like other tools in the Graphics toolbar, the Rotate tool is also a transparent tool. (T/F)

6.	 You can create line segments tangent to arcs by using the _______________ tool from the 
Draw toolbox.

7.	 In the DesignModeler window, user actions are recorded in the ____________________ 
window.

8.	 You can switch to the Sketching mode by choosing the Sketching tab available at the 
bottom of the Tree Outline	  window.

9.	 In the DesignModeler window, you can change the dimension of the entities by specifying 
the new values in the _____________ window.

10.	 In DesignModeler, the Vertical constraint is represented by _____ symbol.
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Exercises
Exercise 1

Create the model shown in Figure 3-113. The dimensions of the model are shown in 
Figure 3-114.  							         (Expected time: 30 min)

Figure 3-114  Dimensions of the model for 
Exercise 1

Figure 3-113  Model for Exercise 1

Exercise 2
Create the model shown in Figure 3-115. The dimensions of the model are shown in 
Figure 3-116.							         (Expected time: 45 min)

Figure 3-116  Dimensions for Exercise 2Figure 3-115  Model for Exercise 2
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Exercise 3
Create the model shown in Figure 3-117. The dimensions of the model are shown in 
Figure 3-118.							         (Expected time: 45 min)

Figure 3-117  Model for Exercise 3

Figure 3-118  Dimensions of the model for Exercise 3

Answers to Self-Evaluation Test
1. T, 2. F, 3. F, 4. T, 5. T, 6. T, 7. Draw, 8. Equal Length, 9. Modify, 10. Tree Outline


